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Introduction

A radio frequency (RF) power supply is used to supply power to a capacitively coupled 
plasma (CCP). Commercially available RF power supplies are specified to deliver power 
into a 50 ohm load, and interconnecting coaxial cables and connectors have a 50 ohm 
characteristic impedance. On the other hand the CCP impedance is typically not equal to 
50 ohm and has both resistive and reactive components. For instance in this example the 
plasma impedance is  at 13.56 MHz and 10 W. A matching network is 
introduced between the RF power supply and the CCP allowing maximum power transfer 
and a safe operating region for the power supply. In operation the match components may 
be fixed or variable and “tuned” either manually or automatically. Modern plasma reactors 
may be powered by multiple power supplies at different operating frequencies. This note 
shows how a match can be designed using dimensions of the chamber, properties of the 
feed gas and the specification of the power supply.

Model Definition

Figure 1 is a schematic of a RF power supply (Vs, Rs) connected to a L–type match 
network (Lm, Cp) with an additional DC blocking capacitor (Cb). The match network is 
connected to a plasma load with a parallel stray capacitance (Cs). The plasma voltage and 
current are V and I.

Figure 1: L–match including blocking and stray capacitance.

Figure 2 shows a simplified schematic, in this case the blocking capacitor (Cb) is removed 
(since the discharge is symmetric and there will be no DC self-bias). The stray capacitance 
(Cs) is ignored.

Zp Rp jXp+=
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Figure 2: L–match used in this model.

In order to compute the optimum values for the parallel capacitor Cp and the inductor Lm, 
the plasma impedance is required, Zp. Using  and the generator source 
resistance, Rs, the following can be used to compute Cp and Lm. Defining:

 (1)

and

 (2)

then the match inductance is given by:

 (3)

and the parallel capacitance is given by:

.  (4)

Results and Discussion

In order to evaluate the results, two meaningful measures are used, the maximum power 
transfer coefficient and the efficiency. The maximum power transfer is given by:

 (5)
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where Vs is the generator voltage, and the maximum power transfer coefficient is then 
given by:

.  (6)

The efficiency is then simply:

 (7)

where Ps is the power lost in the generator.

Figure 3 shows that the maximum of power transfer coefficient is 1 when the plasma 
power dissipation is 10 W. This is expected because the values of Cp and Lm used to 
calculated the match components were determined at 10 W plasma power. 

Figure 4 and Figure 5 show a plot of maximum power transfer coefficient as a function of 
frequency and pressure respectively. Matching occurs at 13.56 MHz and 1 torr 
corresponding to the conditions used to determine Cp and Lm. At low pressure the plasma 
is more resistive and a significant mismatch occurs. The effect is less pronounced at higher 
pressures.

Effect of Harmonics

Finally, the plasma impedance was measured at 50 W, a match was designed. Figure 6 
shows the power transfer coefficient as a function of power. It is evident that the maximum 
value is around 45 W, 10% lower than expected.

The match parameters are calculated from the voltage and current amplitudes at the 
fundamental frequency. However the current waveform has a significant third harmonic 
contribution (4.5%) which accounts for the difference between the measured and 
calculated power at maximum power transfer coefficient.

These results show how a matching network for a CCP reactor can be designed using the 
dimensions of the reactor, the properties of the feed gas and the characteristics of the 
generator. Estimates of the power transfer coefficient as a function of power frequency and 
pressure can be made. The same procedure can be used for 2D reactor geometries.

α
Pplasma
Pmax
-----------------=

η
Pplasma

Pplasma Ps+
------------------------------=
4 |  I M P E D A N C E  M A T C H I N G



Figure 3: Plot of the power transfer coefficient and efficiency versus power.

Figure 4: Plot of the power transfer coefficient and efficiency versus frequency.
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Figure 5: Plot of the power transfer coefficient and efficiency versus pressure.

Figure 6: Plot of the power transfer coefficient and efficiency versus power at high power.
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impedance_matching

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, The model is set up in an identical way to the computing 
plasma impedance model, except an external circuit is used to drive the discharge.

2 click 1D.

3 In the Select Physics tree, select Plasma > Plasma, Time Periodic (ptp).

4 Click Add.

5 Click Study.

6 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > 
Time Periodic.

7 Click Done.

G E O M E T R Y  1

Add parameters to compute the match inductance and capacitance.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.
7 |  I M P E D A N C E  M A T C H I N G



3 In the table, enter the following settings:

G E O M E T R Y  1

Interval 1 (i1)
1 In the Model Builder window, under Component 1 (comp1) right-click Geometry 1 and 

choose Interval.

2 In the Settings window for Interval, locate the Interval section.

3 In the table, enter the following settings:

4 Click Build All Objects.

5 Click the Zoom Extents button in the Graphics toolbar.

Name Expression Value Description

L 0.025[m] 0.025 m Discharge gap

de 0.3[m] 0.3 m Electrode diameter

As 0.25*pi*de^2 0.070686 m² Electrode area

P0 10[W] 10 W Input power

f0 13.56E6[Hz] 1.356E7 Hz Frequency

p0 1[torr] 133.32 Pa Pressure

T0 300[K] 300 K Temperature

Rp 42.696[ohm] 42.696 Ω Plasma impedance, 
real part

Xp -156.62[ohm] -156.62 Ω Plasma impedance, 
imaginary part

Rs 50[ohm] 50 Ω Generator impedance

fmatch 13.56E6[Hz] 1.356E7 Hz Frequency at perfect 
match

Xmd sqrt(Rp*Rs-Rp^2)-Xp 174.28 Ω Match help variable

Bm ((1/(Rp*Rs))-(1/
Rs^2))^0.5

0.0082721 S Match help variable

Lm Xmd/(2*pi*fmatch) 2.0455E-6 H Inductance

Cp Bm/(2*pi*fmatch) 9.7091E-11 F Capacitance

Coordinates (m)

0

L
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P L A S M A ,  T I M E  P E R I O D I C  ( P T P )

1 In the Model Builder window, under Component 1 (comp1) click Plasma,

Time Periodic (ptp).

2 In the Settings window for Plasma, Time Periodic, locate the Cross-Section Area section.

3 In the A text field, type As.

4 Locate the Extra Dimension Settings section. In the Pxd text field, type 1/f0.

5 In the N text field, type 30.

6 Locate the Plasma Properties section. Select the 
Use reduced electron transport properties checkbox.

Cross Section Import 1
1 In the Physics toolbar, click Global and choose Cross Section Import.

2 In the Settings window for Cross Section Import, locate the Cross Section Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
He_xsecs.txt.

5 Click Import.

Species: He
1 In the Model Builder window, click Species: He.

2 In the Settings window for Species, locate the Species Formula section.

3 Select the From mass constraint checkbox.

4 Locate the General Parameters section. From the Preset species data list, choose He.

Species: Hes
1 In the Model Builder window, click Species: Hes.

2 In the Settings window for Species, locate the General Parameters section.

3 From the Preset species data list, choose He.

Species: He+
1 In the Model Builder window, click Species: He+.

2 In the Settings window for Species, locate the Species Formula section.

3 Select the Initial value from electroneutrality constraint checkbox.

4 Locate the General Parameters section. From the Preset species data list, choose He.

5 Locate the Mobility and Diffusivity Expressions section. From the Specification list, choose 
Specify mobility, compute diffusivity.
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6 From the Ion temperature list, choose Use local field approximation.

7 Locate the Mobility Specification section. From the Specify using list, choose 
Helium ion in helium.

Plasma Model 1
1 In the Model Builder window, click Plasma Model 1.

2 In the Settings window for Plasma Model, locate the Model Inputs section.

3 In the T text field, type T0.

4 In the pA text field, type p0.

Surface Reaction 1
1 In the Physics toolbar, click Boundaries and choose Surface Reaction.

2 In the Settings window for Surface Reaction, locate the Boundary Selection section.

3 From the Selection list, choose All boundaries.

4 Locate the Reaction Formula section. In the Formula text field, type He+=>He.

5 Locate the Reaction Parameters section. In the γf text field, type 0.

6 Locate the Secondary Emission Parameters section. In the γi text field, type 0.1.

7 In the εi text field, type 5.8.

2: He+=>He
1 Right-click 1: He+=>He and choose Duplicate.

2 In the Settings window for Surface Reaction, locate the Reaction Formula section.

3 In the Formula text field, type Hes=>He.

4 Locate the Reaction Parameters section. In the γf text field, type 1.

Wall 1
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, locate the Boundary Selection section.

3 From the Selection list, choose All boundaries.

Ground 1
1 In the Physics toolbar, click Boundaries and choose Ground.

2 Select Boundary 2 only.

Metal Contact 1
1 In the Physics toolbar, click Boundaries and choose Metal Contact.

2 Select Boundary 1 only.
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3 In the Settings window for Metal Contact, locate the Terminal section.

4 From the Terminal type list, choose Circuit.

5 From the Circuit type list, choose L-network.

6 From the Source type list, choose Power source.

7 Locate the Circuit Settings section. In the Ps text field, type P0.

8 In the Rs text field, type Rs.

9 In the Cp text field, type Cp.

10 In the Lm text field, type Lm.

11 In the fp text field, type f0.

M E S H  1

Edge 1
In the Mesh toolbar, click Edge.

Distribution 1
1 Right-click Edge 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 From the Distribution type list, choose Predefined.

4 In the Number of elements text field, type 125.

5 In the Element ratio text field, type 10.

6 Select the Symmetric distribution checkbox.

7 Click Build All.

Since we’re not really interested in the spatial distribution of the plasma variables, disable 
the default plots.

P O W E R  S W E E P

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Power Sweep in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots checkbox.

4 Clear the Generate convergence plots checkbox.

First, sweep over power.

Step 1: Time Periodic
1 In the Model Builder window, under Power Sweep click Step 1: Time Periodic.
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2 In the Settings window for Time Periodic, click to expand the Study Extensions section.

3 Select the Auxiliary sweep checkbox.

4 Click Add.

5 In the table, enter the following settings:

6 Click to select the first row in the table.

7 Click Range.

8 In the Range dialog, choose Number of values from the Entry method list.

9 In the Start text field, type 1.

10 In the Stop text field, type 30.

11 In the Number of values text field, type 50.

12 Click Replace.

13 In the Settings window for Time Periodic, locate the Study Extensions section.

14 In the table, enter the following settings:

15 In the Study toolbar, click Compute.

R E S U L T S

Add a plot to see how the efficiency changes with power.

1D Plot Group 1
1 In the Model Builder window, expand the Results node.

2 Right-click Results and choose 1D Plot Group.

Global 1
1 In the Model Builder window, right-click 1D Plot Group 1 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-Axis Data section. From the menu, choose Component 1 (comp1) > Plasma,

Time Periodic > Metal Contact 1 > ptp.mct1.alphaP -

Maximum power transfer coefficient - 1.

Parameter name Parameter value list Parameter unit

P0 (Input power) W

Parameter name Parameter value list Parameter unit

P0 (Input power) range(1,0.5918367346938775,30) W
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3 Click Add Expression in the upper-right corner of the y-Axis Data section. From the 
menu, choose Component 1 (comp1) > Plasma, Time Periodic > Metal Contact 1 > 
ptp.mct1.etaP - Efficiency - 1.

4 In the 1D Plot Group 1 toolbar, click Plot.

Power Sweep
1 In the Model Builder window, click 1D Plot Group 1.

2 In the Settings window for 1D Plot Group, locate the Plot Settings section.

3 Select the y-axis label checkbox. In the associated text field, type Maximum power 
transfer efficiency (1) and efficiency (1).

4 Click to expand the Title section. From the Title type list, choose None.

5 Locate the Legend section. From the Position list, choose Lower right.

6 In the 1D Plot Group 1 toolbar, click Plot.

7 In the Label text field, type Power Sweep.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Time Periodic.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Time Periodic
Now sweep over frequency.

1 In the Settings window for Time Periodic, locate the Study Extensions section.

2 Select the Auxiliary sweep checkbox.

3 Click Add.

4 In the table, enter the following settings:

5 Click to select the first row in the table.

Parameter name Parameter value list Parameter unit

f0 (Frequency) Hz
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6 Click Range.

7 In the Range dialog, type 11 in the Start text field.

8 From the Entry method list, choose Number of values.

9 In the Stop text field, type 16.

10 In the Number of values text field, type 51.

11 Click Replace.

12 In the Settings window for Time Periodic, locate the Study Extensions section.

13 In the table, enter the following settings:

14 In the Model Builder window, click Study 2.

15 In the Settings window for Study, locate the Study Settings section.

16 Clear the Generate default plots checkbox.

17 Clear the Generate convergence plots checkbox.

18 In the Label text field, type Frequency Sweep.

19 In the Study toolbar, click Compute.

R E S U L T S

Frequency Sweep
1 In the Model Builder window, right-click Power Sweep and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Frequency Sweep in the Label text field.

3 Locate the Data section. From the Dataset list, choose Frequency Sweep/Solution 2 (sol2).

Global 1
1 Click the Zoom Extents button in the Graphics toolbar.

2 From the Home menu, choose Add Study.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Time Periodic.

3 Click the Add Study button in the window toolbar.

4 From the Home menu, choose Add Study.

Parameter name Parameter value list Parameter unit

f0 (Frequency) range(11,0.1,16) MHz
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S T U D Y  3

Step 1: Time Periodic
Next, sweep over pressure.

1 In the Settings window for Time Periodic, locate the Study Extensions section.

2 Select the Auxiliary sweep checkbox.

3 Click Add.

4 In the table, enter the following settings:

5 Click to select the first row in the table.

6 Click Range.

7 In the Range dialog, choose Number of values from the Entry method list.

8 In the Start text field, type 2.

9 In the Stop text field, type 0.4.

10 In the Number of values text field, type 30.

11 Click Replace.

12 In the Settings window for Time Periodic, locate the Study Extensions section.

13 In the table, enter the following settings:

14 In the Model Builder window, expand the Frequency Sweep node, then click Study 3.

15 In the Settings window for Study, type Pressure Sweep in the Label text field.

16 Locate the Study Settings section. Clear the Generate default plots checkbox.

17 Clear the Generate convergence plots checkbox.

18 In the Study toolbar, click Compute.

R E S U L T S

Pressure Sweep
1 In the Model Builder window, right-click Frequency Sweep and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Pressure Sweep in the Label text field.

Parameter name Parameter value list Parameter unit

p0 (Pressure) Pa

Parameter name Parameter value list Parameter unit

p0 (Pressure) range(2,-0.055172413793103454,
0.4)

torr
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3 Locate the Data section. From the Dataset list, choose Pressure Sweep/Solution 3 (sol3).

Global 1
1 In the Model Builder window, expand the Pressure Sweep node, then click Global 1.

2 In the Settings window for Global, locate the x-Axis Data section.

3 From the Unit list, choose Torr.

4 In the Pressure Sweep toolbar, click Plot.

Finally, change the impedance so that the match occurs at 50 W, then sweep over power 
once more.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Time Periodic.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  4

Step 1: Time Periodic
1 In the Settings window for Time Periodic, locate the Study Extensions section.

2 Select the Auxiliary sweep checkbox.

3 Click Add.

Name Expression Value Description

Rp 29.175[ohm] 29.175 Ω Plasma impedance, real part

Xp -126.47[ohm] -126.47 Ω Plasma impedance, imaginary 
part
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4 In the table, enter the following settings:

5 Click to select the first row in the table.

6 Click Range.

7 In the Range dialog, choose Number of values from the Entry method list.

8 In the Start text field, type 10.

9 In the Stop text field, type 80.

10 In the Number of values text field, type 51.

11 Click Replace.

12 In the Settings window for Time Periodic, locate the Study Extensions section.

13 In the table, enter the following settings:

14 In the Model Builder window, click Study 4.

15 In the Settings window for Study, locate the Study Settings section.

16 Clear the Generate convergence plots checkbox.

17 Clear the Generate default plots checkbox.

18 In the Label text field, type High Power Sweep.

19 In the Study toolbar, click Compute.

R E S U L T S

1D Plot Group 4
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Dataset list, choose High Power Sweep/Solution 4 (sol4).

Global 1
1 Right-click 1D Plot Group 4 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-Axis Data section. From the menu, choose Component 1 (comp1) > Plasma,

Parameter name Parameter value list Parameter unit

P0 (Input power) W

Parameter name Parameter value list Parameter unit

P0 (Input power) range(10,1.4,80) W
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Time Periodic > Metal Contact 1 > ptp.mct1.alphaP -

Maximum power transfer coefficient - 1.

3 In the 1D Plot Group 4 toolbar, click Plot.

Global 2
1 In the Model Builder window, right-click 1D Plot Group 4 and choose Global.

2 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-Axis Data section. From the menu, choose Component 1 (comp1) > Plasma,

Time Periodic > Metal Contact 1 > ptp.mct1.etaP - Efficiency - 1.

High Power Sweep
1 In the Model Builder window, under Results click 1D Plot Group 4.

2 In the Settings window for 1D Plot Group, type High Power Sweep in the Label text 
field.

3 Locate the Plot Settings section. Select the Two y-axes checkbox.

4 In the table, select the Plot on secondary y-axis checkbox for Global 2.

5 Locate the Title section. From the Title type list, choose None.

6 Locate the Legend section. From the Position list, choose Lower right.

7 In the High Power Sweep toolbar, click Plot.

8 Click the Zoom Extents button in the Graphics toolbar.
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